
Evaluation License

If you would like to try NEWT Professional on your entire network for up to 30
days, Komodo Laboratories extends the offer of a one month Evaluation
License.  To request an Evaluation License, please email
sales@komodolabs.com with the following information:

Organization name
User name
Number of licenses you would like to try

Komodo Laboratories reserves the right to refuse requests from non-corporate
email addresses.

mailto:sales@komodolabs.com


To make your buying experience more pleasant, we provide a number
of purchase options.

Purchase OrdersWe encourage our North American customers to buy
using Purchase Orders when it is convenient.  International customers who
have offices in North America may also qualify to purchase  To buy using a
Purchase Order, please contact sales@komodolabs.com for quick and friendly
service.

Website
Credit card and wire transfer orders may be placed through the Purchase link
on our website. You may also visit
http://www.komododigital.com/Purchase.htm to place an order.  All major
credit cards are accepted.

Company Check
Orders may also be prepaid using a company check.  Please contact
sales@komodolabs.com for more information.

 

mailto:sales@komodolabs.com
http://www.KomodoLabs.com
http://www.komododigital.com/Purchase.htm
mailto:sales@komodolabs.com


How to License

First, select Licensing... from the Help menu.

Next copy the license key from email, and paste into the License Key box.  Name and organization
will be filled in automatically after restarting the program.



After pasting the license key, you will be presented with the above message.  After clicking OK, exit
our application and re-run it.

Select About... from the Help menu to confirm the licensing.

If you have trouble licensing the product, please contact support@komodolabs.com

mailto:support@komodolabs.com


Scan Items & Properties

The Scan Properties window provides the ability to limit a scan to only the
items needed for a scan.  Previous scan results are not affected by deselecting
scan items.

 
System

Chassis Type (WMI)Describes the general use of the computer's
motherboard by reading the DMI (Desktop Management Interface) using WMI.



This can be one of the following: Desktop, Low Profile Desktop, Pizza Box, Mini
Tower, Tower, Portable, Laptop, Notebook, Hand Held, Docking Station, All in
One, Sub Notebook, Space-Saving, Lunch Box, Main System Chassis,
Expansion Chassis, SubChassis, Bus Expansion Chassis, Peripheral Chassis,
Storage Chassis, Rack Mount Chassis, Sealed-Case PC, Unknown or Other.

System Type
Reports whether a system is ACPI (Advanced Configuration and Power
Interface) enabled.  The system supports system shutoff by power button and
has power management capabilities when ACPI is enabled.

System Manufacturer
Manufacturer of the system, found by reading the DMI (Desktop Management
Interface) using WMI. This is often used in conjunction with the Motherboard
Manufacturer item to identify the manufacturer of the system or motherboard.

System Model
Model of the system, found by reading the DMI (Desktop Management
Interface) using WMI. This is often used in conjunction with the Motherboard
Model item to identify the model of the system or motherboard.

Motherboard Manufacturer
Manufacturer of the motherboard, found by reading the DMI (Desktop
Management Interface) using WMI. This is often used in conjunction with the
System Manufacturer item to identify the manufacturer of the system or
motherboard.

Motherboard Model
Model of the motherboard, found by reading the DMI (Desktop Management
Interface) using WMI. This is often used in conjunction with the System Model
item to identify the model of the system or motherboard.

CPU Type
Displays the type and codename of a CPU in a meaningful form, i.e. Pentium
4/Prescott.

CPU Type (Extended Info)
Shows extended information about the CPU if provided, i.e. mobile AMD
Athlon(tm) 4 2400+.



MHz
CPU speed in MHz.

CPUs (Physical)
The number of true physical CPUs in a system. The difference between
physical and logical CPUs can help determine whether a multi-core CPU is
running in simultaneous multithreading (SMT) mode, more commonly referred
to as HyperThreading in Intel processors. HyperThreading can be
considered enabled if the number of logical CPUs exceeds the number of
physical CPUs.

CPUs (Logical)
The number of CPUs as reported by the operating system. Windows is
incapable of distinguishing between physical and logical CPUs in a system.
Therefore if there are 2 physical CPUs or dual CPUs, 2 logical CPUs will be
reported. The difference between physical and logical CPUs can help
determine whether a multi-core CPU is running in simultaneous
multithreading (SMT) mode, more commonly referred to as HyperThreading in
Intel processors. HyperThreading can be considered enabled if the number of
logical CPUs exceeds the number of physical CPUs.

Physical Memory
The total amount of memory available to the system. Any on-board shared
video memory is subtracted from this value.

Memory Capacity (WMI)
Displays the memory capacity of the motherboard by reading the DMI
(Desktop Management Interface) using WMI.
IMPORTANT NOTE: This value is programmed into the BIOS by the system
manufacturer and cannot be guaranteed.

BIOS Description
BIOS information as input by the BIOS manufacturer. This usually includes
the manufacturer name and BIOS version.

BIOS Date
Date when the BIOS was released.

Video Adapter
Displays the primary video adapter used by the system, although there may
be more then one adapter in the system.



Video Resolution
Current video resolution as set in the operating system by the user.

Video Refresh Rate
The vertical refresh frequency as set in the operating system for the primary
video adapter driving the primary monitor. This item is useful in determining
the safety of the refresh rate. Low refresh settings on CRT monitors have
been known to cause eye strain and headaches when viewed for long periods.
CRT's should never be ran at 60hz. when they're being viewed for an
extended time. 85hz. is recommended to reduce this strain. LCD monitors are
safe to view at any refresh rate setting. They do not make use of the refresh
rate, so this value may therefore be ignored on such displays.

Video Memory Size
Amount of RAM memory in computer's video adapter. On board video adapters
reduce the Physical Memory, or total available memory to the system.

Audio Device
The current selected audio device in the operating system.

Monitor Manufacturer
Displays the manufacturer of the monitor. NEWT Professional determines this
in two stages. It first checks to see if the correct driver is installed as shown
under Display Properties in Windows. If this value is generic, NEWT
Professional uses low-level DDC (Display Data Channel) information available
to the operating system to determine the manufacturer. The monitor must be
on during the last boot of the OS, but does not need to be on at the time of
the scan. This item should show "Monitor off during boot?" if the monitor was
off at the time of boot.
NOTE: Notebook computer LCDs are often improperly programmed by the
manufacturer and may show the "Monitor off during boot?" error.

Monitor Model
This item shows the model of the monitor. NEWT Professional determines this
in two stages. It first checks to see if the correct driver is installed as shown
under Display Properties in Windows. If this value is generic, NEWT
Professional uses low-level DDC (Display Data Channel) information available
to the operating system to determine this value. The monitor must be on
during the last boot of the OS, but does not need to be on at the time of the
scan. This item should show "Monitor off during boot?" if the monitor was off



at the time of boot.
NOTE: Notebook computer LCDs are often improperly programmed by the
manufacturer and may show the "Monitor off during boot?" error.

Monitor Type
Shows the monitor type as CRT or LCD.  NEWT Professional uses low-level
DDC (Display Data Channel) information available to the operating system to
determine this value. The monitor must be on during the last boot of the OS,
but does not need to be on at the time of the scan. This item should show
"Monitor off during boot?" if the monitor was off at the time of boot.
NOTE: Notebook computer LCDs are often improperly programmed by the
manufacturer and may show the "Monitor off during boot?" error.

Monitor Size
Displays the monitor's manufacturer advertised size in inches. This is usually
1 to 2 inches larger than the viewable size on CRT displays. LCD advertised
sizes are the same as their viewable size. In other words if you have a 19"
CRT and a 19" LCD, the LCD has a larger viewable size and should be
preferable when maximum viewing size is desired.  NEWT Professional uses
low-level DDC (Display Data Channel) information available to the operating
system to determine this value. The monitor must be on during the last boot
of the OS, but does not need to be on at the time of the scan. This item
should show "Monitor off during boot?" if the monitor was off at the time of
boot.
NOTE: Notebook computer LCDs are often improperly programmed by the
manufacturer and may show the "Monitor off during boot?" error.

Monitor Aspect Ratio
This item reports the aspect ratio of the monitor. Most CRTs have a 4:3 ratio,
but LCDs may have 4:3, 5:4 or even 16:9 (widescreen). This value is
calculated based on the Monitor's Maximum Resolution.

Monitor Max. Res (Maximum Resolution)
This is the monitor's maximum resolution as reported by the operating
system. In some cases this value may differ depending on the computer to
which the monitor is attached.

Monitor Serial Number
The manufacturer's serial number for the display monitor. This value can
differ slightly from the from the serial number printed on the back of monitor
itself, but should always be unique and therefore allow you to differentiate it



from all other monitors. Manufacturers often omit their serial number prefix
when programming the monitor with this value.  NEWT Professional uses low-
level DDC (Display Data Channel) information available to the operating
system to determine this value. The monitor must be on during the last boot
of the OS, but does not need to be on at the time of the scan. This item
should show "Monitor off during boot?" if the monitor was off at the time of
boot.
NOTE: Notebook computer LCDs are often improperly programmed by the
manufacturer and may show the "Monitor off during boot?" error.

Monitor Manufacture Date
The monitor's manufacturer week. Only the week and year of the
manufacture date is programmed into monitors. NEWT Professional makes this
information more meaningful by displaying the date for the first Sunday of
that week.

Serial Number (WMI)
The serial number, often called the asset tag. This value is set in the BIOS by
the manufacturer and cannot be changed by the user. Values of "0",
consecutive zeros, series of numbers such as "1234567890" are ones
improperly programmed by the manufacturer of the system. Manufacturers
such as Dell, Compaq, Gateway and IBM usually program serial numbers
correctly, while OEM motherboards like A-bit, ASUS, Gigabyte, etc, do not.

Windows

Operating System
This value is determined in real time and usually does not need to be
scanned. However you can force NEWT Professional to scan for this item by
enabling "Scan NetBIOS items" under Preferences. This may also be viewed
by browsing the network with NEWT Professional's Network Browser.
Currently NEWT Professional  detects the following operating system Windows
NT 4.0, Windows 2000, Windows 2003, Windows XP, Windows 9x/ME, Samba,
Snap Server, Windows for Workgroups, Lanman Server, Linux or Print Server.

Service Pack
Shows the current service pack, as reported by Windows.

OS Type (Database)
This item uses NEWT Professional's proprietary database to help determine



the type of operating system in real time in the Network Browser. Example
values are Professional, Server, PDC (Primary Domain Controller).

OS Type (WMI)
This is similar to the database OS Type except that it is scanned using WMI
and is usually more reliable.

Windows Install Date
Date when Windows was installed.

Windows Install Path
Path where Windows is installed.

Screen Saver
The path of the screensaver, as set in Windows.

Screen Saver Timeout
Timeout setting for the screensaver, as set by the user.

Screen Saver Secure
Indicates if Windows is set to require a password when returning from
screensaver mode.

Clock Reading
Current clock reading at the time of scan.

Clock Variance
Shows the difference between the clock reading on the remote machine and
the local machine.

Uptime
Shows how long the remote machine has been on since the last boot up.

Boot Time
Displays the time when Windows was last booted.

Time Zone
Indicates the time zone set in the operating system.

Daylight Savings
When set to "Automatic" this indicates Windows is set to automatically adjust



the computer's clock for daylight saving time changes.

Windows Product ID
The Product ID is converted by Windows from the Product Key (CD Key).
Often this value is used by Microsoft to determine if an installation is
legitimate when installing service packs.

Windows Product Key
This is the actual serial number or CD key input by the user when the OS was
installed. There may be many systems on the network with the same CD key.
This usually indicates a volume license, but may also indicate piracy. The
Itemization tool can be used to show a list of all unique keys and how many
are used of each.

Registered Owner
Windows Registered Owner as input during the OS install.

Registered Organization
Windows Registered Organization as input during the OS install.

Automatic Update Options
This value indicates the option for Windows Automatic Updates.

Automatic Update Status
Displays the status of Windows Automatic Updates.

Network

IP Address
This is the resolved IP address, or the address the remote computer is using
to connect to the particular network it is being scanned from. Although there
may be more than one network adapter and therefore more than one IP
address, at this time NEWT Professional will only display the resolved IP
address.

MAC Address
Short for Media Access Control address, the hardware address that uniquely
identifies each device on the network that also uses an IP address. This
address never changes except in very rare cases where it is specifically



changed by the user.

MAC Address Owner
Displays the company who owns the MAC address. This is usually the
manufacturer of the device or network adapter and is useful for determining
routers, print servers and the like.

Group
Displays the domain or workgroup the computer is logged on to.

Domain Role (WMI)
Used to determine a computer's domain role by reading the DMI (Desktop
Management Interface) using WMI.
Values can be one of Standalone Workstation, Member Workstation,
Standalone Server, Member Server, Backup Domain Controller or Primary
Domain Controller.

Username
Displays the last logged on user. When a user is logged on, this is the
currently logged on user.

Ping
Ping reply time in milliseconds.

Ping TTL (Time-to-Live)
Time-to-Live (TTL) is a value within an IP packet header.  It's value is
between 0 and 255 and is initialized by the originating host.  As the packet is
passed through a network, the TTL is generally decreased by 1 each time it
passes through a router.  When a router detects the TTL value of a packet is
zero, the packet is discarded and an ICMP message is sent to the originating
host of the packet.  If you know the initial setting, the Ping TTL can be used to
determine the number of router hops between the local and scanned
machines.

Comment
A NetBIOS item, it is equivalent to the Comment column in Windows'
"Network Neighborhood" or "My Network Places". This value is determined in
real time and usually does not need to be scanned. However you can force
NEWT Professional to scan for this item by enabling "Scan NetBIOS items"
under Preferences. This can also be viewed by browsing the network with
NEWT Professional's Network Browser.



Primary Network Adapter
This represents the main network adapter used to connect to the network.
Currently NEWT Professional only scans for this adapter even though there
may be more than one in the system. Future versions may list all network
adapters.

IP Type (Static/DHCP)
Displays the IP type as set under Internet Protocol (TCP/IP) Properties. This
can be static or DHCP. Static denotes that the IP address, gateway, subnet
mask and DNS servers have been manually entered. DHCP indicates the
computer obtains the aforementioned settings from a DHCP server, usually a
router or other network device.

DHCP Server
Shows the DHCP server's IP address if Windows TCP/IP Properties is set to
"Obtain IP address automatically" for the primary network adapter. "N/A" is
displayed if IP Type is static.

Gateway
Indicates the Default Gateway as set under Windows Internet Protocol
(TCP/IP) Properties for the primary network adapter.

Subnet Mask
Indicates the Subnet Mask as set under Windows Internet Protocol (TCP/IP)
Properties for the primary network adapter.

DNS Servers
Lists DNS Servers as set under Windows Internet Protocol (TCP/IP) Properties
for the primary network adapter.

MTU Setting
Short for Maximum Transmission Unit, it defines the maximum size of a
packet that can be transferred in one frame over a network. Values lower
than 1500 may cause a decrease in network speed. Normally Windows does
not allow changing of this setting, except when changed directly through the
registry.

Internet Explorer Version
Displays the version and service pack of Windows Internet Explorer.



Default Web Browser
Shows the current default web browser as configured by the user.

Default Email Client
Shows the current default email client as configured by the user.

NIC Speed
Actual network connection speed in megabits per second. Common values are
10, 100 and 1000.

NIC Speed Setting
Represents the network speed and duplex setting as configured in the
Advanced Network Connection Properties. Common values are "Auto" or a
variant thereof, 10/100, 100, 1000, etc. Automatic is the recommended
setting in most situations.

Extended Information

Drives-Logical (WMI)
Lists drive letters using WMI (Windows Management Instrumentation)

Drive
Contains the drive letter.
 
Label
Indicates the configurable name of the disk.
 
Type
Typical values are "Local Fixed Disk", "Network Connection" and "CD-ROM Disc"
 
Network Path
Displays the UNC (Universal Naming Convention) path when type is a Network Connection,
i.e. "\\ComputerName\C".
 
File System
Shows the file system if known. Common values are FAT32, NTFS and CDFS.
 
Serial #
Lists disk serial number. Value is unique within limitations and changes when a drive is
formatted or a new disk is inserted for CD/DVD-ROM and removable drives. This is not the
manufacturer warranty serial number.
 
Total (GB)



The total number of gigabytes.
 
Free (GB)
The total number of gigabytes free.
 
Used (GB)
The total number of gigabytes used.
 
% Free
Shows the percentage of free gigabytes.

Drives-Physical
Displays information about IDE, SCSI and USB drives using a variety of methods.

Location
Typical values are "Primary Master", "Secondary Master", etc. for IDE disks. SCSI ID and
LUN locations are generally shown for SCSI drives.
 
Device Type
Common values include "DiskPeripheral" and "CdRomPeripheral" as indicated by the registry.
No translation is made.
 
Bus Type
Shows the type of bus for the current drive. Examples are "IDE", "SCSI" and "USB".
 
Device Name
Indicates the device name, as encoded by the manufacturer.
 
Total Size (GB)
Displays the advertised size of IDE drives, as opposed to formatted size.
 
Health
Signifies the health of an IDE drive using S.M.A.R.T. (Self-Monitoring Analysis and Reporting
Technology). This technology is used by hard drive manufacturers to help predict reliability and
prevent data loss when the data is reported by the computer through software applications.
NEWT Professional reads this information for IDE drives and compares the current and worst
values with the manufacture's safety threshold. OK is indicated when values fall within an
acceptable range. If any of the worst values fall below the threshold, NEWT Professional will
indicate the drive as BAD. Drives marked BAD are cause for warranty replacement by most
manufacturers. The "Warranty Serial Number" (see below) can be used to look up a drive's
warranty status on the manufacturer website. Clicking on the button associated with the drive
will show drive specific SMART values. SCSI drives are not yet supported.
 
Warranty Serial Number
This shows an IDE drive's true serial number, as needed for manufacturer warranty



replacement.
 
Buffer Size (MB)
The buffer is the memory cache of a drive. This cache is a repository for the temporary storage
of data awaiting the next likely request of a computer. Because random-access-memory (RAM)
is much faster than mechanical rotating storage, the buffer can speed up performance. The larger
the buffer size, the better the drive should perform. Most newer hard drives have buffers of at
least 8MB, which is acceptable for most users.
 
Firmware Revision
Hard drive firmware is software that is embedded onto a drive in order to control it. The
firmware revision indicates the version of firmware installed on the drive. Currently only
shown for IDE drives.
 
Partitions
Number of partitions for a drive.
 
Manufacturer
Shows the manufacturer of some USB drives. IDE and SCSI drives may be supported in future
updates.

 

Devices-Shares
Displays drive and printer shares of computers using standard Windows API. Shares can also be
retrieved from Win9x/ME machines.

Name
Lists name of the share as shared by the computer.
 
Type
Typical types include Disk, Printers and Special for Default Administrator shared drives.
 
Path
Shows the local path for the shared device. Examples include "C:\" for drives, or the name of
the printer itself.
 
Comment
User defined comment for the shared device.
 
Total (GB)
The total number of gigabytes.
 
Free (GB)
The total number of gigabytes free.



 
Used (GB)
The total number of gigabytes used.
 
% Free
Shows the percentage of free gigabytes.

Environment Variables
Lists Windows environment variables.

Variable Name
The name of the variable.
 
Value
Shows the value of the variable.

Fonts
List all installed Windows fonts.

Font Name
The name of the font as created by font developer.
 
Type
Type of font, commonly TrueType.
 
Path
Full path where the font resides. Font is usually located in the Windows/Font path when only
the font's filename is shown.

Hot Fixes
The hot fixes tab shows individual updates that may or may not be related to service packs.

Hot Fix
Shows Microsoft knowledge base article number. Clicking on an article in this list opens your
default web browser to Microsoft's knowledge base and displays information about the update.
The prefix URL for hot fixes can be changed through Preferences in case Microsoft changes
their addressing structure.
 
Install Date
Date when the hot fix was installed.
 
Type
The type of hot fix usually contains the Windows version and the service pack each fix belongs
to.
 



Description
This item is usually redundant, but may show additional information about the hot fix.
 
Updated Files
Lists all files affected by this particular update.

Printers
The printers tab lists information about all locally installed printers for the currently logged on user.

Printer Name
The name of the printer as shown in the Windows installed printers.
 
Default
Indicates if this is the default printer.
 
Documents
Shows a count of documents in the printer queue at the time of the scan.
 
Status
Displays the printers status and can be helpful in locating printers with low toner or print queue
issues.
 
Comment
A user-defined comment about the printer, settable in Windows.
 
Location
A user-defined location of the printer, settable in Windows.
 
Shared In
Indicates whether the printer is shared in by this computer.
 
Server Name
If shared in, this shows the name of the computer sharing the remote printer.
 
Shared Out
Shows whether the printer is shared out or not.
 
Share Name
Lists the printer's user-definable share name.
 
Port
The port the printer is connected to. This can be LPT (for parallel), USB, the remote server
name, or the IP address of a standalone printer.
 
Model



This usually displays the name of the printer, but is not user-definable and may be more reliable
in identifying printers.
 
Processor
The print processor used to print documents.
 
Resolution
Displays the DPI (dots per inch) printer resolution as set by the driver.  This feature is not
supported by all printer drivers and therefore may display "unknown".

RAM Slots
This tab displays what type of RAM is in each slot, using low-level methods. This can be very useful
in determining what kind of RAM to purchase, if RAM has been removed, or if the speed of the
RAM is up to IT specifications. Most of the data displayed here is highly accurate except where
noted. Since much of the information programmed into each RAM module depends on the
manufacturer, not all items are available.

IMPORTANT NOTE: The number of slots is determined using a combination of DMI (Desktop
Management Interface) or WMI and therefore may not be accurate on all brands of motherboards.
The slot reported filled by a particular RAM module should be extremely accurate.

Slot #
The slot number correlates to the slot # on the motherboard.
IMPORTANT NOTE: The number of slots is determined using a combination of DMI (Desktop
Management Interface) and WMI and therefore may not be accurate on all brands of
motherboards.  A slot reported filled by a particular RAM module should be extremely
accurate.
 
Manufacturer
RAM module manufacturer name.
 
Size (MB)
Size of the RAM module in megabytes.
 
Pins
Number of pins for this type of RAM, derived from a proprietary database.
 
Speed
Displays the speed of each RAM module. Examples include PC100, PC2100, PC3200, etc.
 
Type
The type of RAM installed, for example DDR-SDRAM, RDRAM, etc.
 
Error Correction
Displays whether the RAM module supports ECC (parity) or not (non-parity). It does not yet



indicate if it is enabled in BIOS.
 
Max. Size (MB)
Maximum size of the RAM module for each slot of the motherboard. This is not programmed
into the RAM module, but instead is read directly from the DMI (Desktop Management
Interface). The accuracy of this value is dependant on the motherboard manufacturer, but has
proven fairly accurate when a number is displayed, and will display as "Unavailable" on
motherboards that don't include this value.
 
Register Type
The term "registered" refers to how the memory module processes signals. Registered modules
contain a register that delays all information transferred to the module by one clock cycle. This
type of memory is primarily used in servers.  While most PCs will accept only unbuffered
memory modules, there are some that accept registered memory modules. Keep in mind when
you install registered memory modules, all of the modules installed must be registered because
unbuffered and registered modules are not interchangeable.  Registered memory modules may
be verified by one or more small black chips mounted horizontally on the module itself.
 
Buffer Type
DDR and SDRAM can be unbuffered or registered. EDO and FPM can be buffered or
unbuffered. Buffered modules contain a buffer to help the chipset cope with the large electrical
load required when a system has a lot of memory. Unbuffered memory does not contain the chip
that allows for the extra features in registered and buffered memory. Registered modules do not
have a buffer but do contain a register which delays all information transferred to the module by
one clock cycle. Buffered and registered modules are typically used only in servers and other
mission-critical systems where it is extremely important that the data is properly handled.
Buffered memory is basically the same as registered memory, but the term is used for the older
EDO and FPM memory types.
 
CAS Latency
CAS Latency (also referred to as latency) is the amount of time it takes for the memory to
respond to a command. Specifically, it is the length of time between memory receiving a
command to read data, and the first piece of data being output from memory. Latency is
measured in terms of clock cycles and is often noted as CL2 (two clock cycles) or CL3 (three
clock cycles).
 
Manufacture Date (Week of)
Only the week and year of the manufacture date is programmed into RAM modules. NEWT
Professional makes this information more meaningful by displaying the date for the Sunday of
the week. This feature is not supported by all modules.
 
Serial #
The manufacturer serial number shown in hex form. This feature is not supported by all
modules.
 



Model ID
This refers to the proprietary model when needing to order the exact RAM from a particular
manufacturer.
 
Refresh Rate
In order to store data, DRAM needs a constant supply of electricity. "Refresh" is the process of
re-charging the individual cells in a DRAM chip.

Services
Shows all Windows services using WMI (Windows Management Instrumentation)

Display Name
The name of the service in meaningful, longer form.
 
Service Name
The name of the service in the short form used by programmers.
 
State
This value indicates whether the service is running, paused or stopped.
 
Type
Displays if a service is a member of the owner or share group.
Start Type
The startup type as set by the user or a process. This can be Auto, Manual or Disabled.
 
Log On As
Displays the account on which the service runs.
 
Interactive
Indicates whether the service can interact with the desktop GUI.
 
Path Name
Exact path and arguments for the service.
 
Process ID
The process ID of a service EXE as seen under Windows Task Manager. Services with an ID
of zero are either stopped or do not have a process ID.
 
Description
A full length description of each service.

Software
This tab lists software installed in the computer and should match the "Add/Remove Programs" in
the Control Panel. Not all publishers support all fields.



Software
Shows the full name of the installed application.
 
Publisher
This is usually the name of the company who developed the application.
 
Version
Version number of the installed software.
 
Install Date
Date the application was installed. Most installers do not support this feature.
 
Product Key
The actual CD key or serial number used to install a Microsoft Office XP and 2003 product.
Office 2000 products do not store the CD key, therefore it isn't retrievable.
 
Product ID
The product ID is usually derived from the Product Key by Microsoft at the time of installation.
Many times this is used to verify to an update installer the software is legitimate.
 
Registered Company
The company to which the software is registered, as entered by the user.
 
Registered Owner
The owner's name to which the software is registered, as entered by the user.
 
Uninstall Path
This shows the executable and command line options used when an uninstall is invoked. This is
supported by all software that include the ability to de-install the application.
 
Install Path
The path and filename of the primary executable for starting the installed application.
 
Use Count
The number of times an application has been started, as reported by Windows.
 
Frequency Used
Based on the Use Count. Values can be Frequently, Occasionally and Rarely.
 
Size (MB)
Estimated size of the installed application in megabytes.
 
Last Used
The date the software was last run, as reported by Windows.



 

Startup Applications
Lists executables that run from the registry during Windows startup. These differ from Startup in
Start Menu/Programs/Startup in Explorer in that they're usually not visible to the user. Many
malware programs use this method to execute.

Name
The name of the startup application as defined by the developer.
 
Path
The executable path to the startup application.
 
Type
Shows on which accounts the software is set to run. Can be either Current User or All Users.
 
Registry Path
Path in the Windows registry from which the software is run. There are currently only two
possible paths.

System Slots (WMI)
Displays information about system slots using WMI. This has proven fairly accurate.

Slot #
The numbered slot corresponding to each slot on the motherboard.
 
Usage
Indicates if the slot is In Use or Available.
 
Type
Typical bus types are PCI, AGP and ISA.
 
Data Width (bits)
The bus data width in bits.
 
Voltage Support
Lists supported voltages for each slot.
 
Status
Displays the operational status of a system slot.

Virtual Memory
Shows virtual memory settings and usage for each.

Path



The local path to the virtual memory page file.
 
Initial Size (MB)
User configured setting in Windows for the initial (or minimum) page file size in megabytes.
 
Maximum Size (MB)
User configured setting in Windows for the maximum page file size in megabytes.
 
Current Usage (MB)
The amount of virtual memory in use at the time of the scan.
 
Peak Usage (MB)
The amount of peak virtual memory used at the time of scan since the last reboot.

Virus Definitions
Lists anti-virus products and information about them. Even though many products use a centralized
update system, this feature can be used as a verification that all definitions are being updated on
schedule.

The following anti-virus products are supported:

Computer Associates eTrust 7.1
McAfee NetShield 4.x
McAfee VirusScan 4.x
McAfee VirusScan 8.x
McAfee VirusScan Enterprise 7.0/7.1
Norton AntiVirus 2003 - 2005
Symantec A/V Corporate Edition 7.x
Trend Micro OfficeScan 6.x

Software Name
Name of the antivirus application.
 
Version
Current installed antivirus application version.
 
Virus Definitions Date
This is usually the date of when the virus definition was released.
 
Age (days)
The Virus Definitions Date and the date of the local computer at the time of scan are used to
calculate the age of each definition.
 
Known Threats
Total threat count supported by the current virus definition. Many, but not all products are



supported.

Buttons
Select All
Selects all checkboxes

Select None
Deselects all checkboxes

Invert Selection
Toggles all checkboxes

Load...
Allows user to load a scan item selection set.

Save...
Allows user to save a scan item selection set.

OK
Closes preferences window and applies any changes

Cancel
Closes preferences window and disregards any changes

 

 



Network Browser
Description The
Network Browser
provides an easy way to
browse the network. 
It's also one of many
places machines can be
scanned from.

Scanning
There are to basic ways
to scan from the
Network Browser.  One
is to simply click on one
or several machines and
click the green scan
button in the tool.  This
will start a scan of the
selected machines
immediately.  The
second method is by
selecting machines and
dragging them to the
Primary tab for
scanning immediately
or at a later time.
 



Discover and Scanning by Group

Switch to Scanning modeThis button switches between scanning and discovery modes. In scanning
mode, discovery is performed, then scanning is performed automatically. In discovery mode, only
discovery is performed, scanning must be initiated manually.

Clear Previous Results
When enabled, all results are cleared before a discovery or scan is made.  Disabling the option
allows discovery of devices or computers that may have been turned off or unavailable during a
previous scan or discovery, while keeping the current results or list.  Enabled by default.

Buttons

Discover or Scan
Initiates discovery or scanning.

Close
Exits the window.



File Menu

Load IP List...Loads an IP list from a saved CSV file, replacing all IP ranges.

Load Append IP List...
Loads an IP list from a saved CSV file, appending IP ranges at the end.

Save IP List...
Saves an IP list in a comma separated value (CSV) format.

IP Entry

Input boxes
These represent the starting and ending of an IP range. NEWT allows a virtually unlimited number of
IP ranges.

New



Creates a new IP range.

Duplicate
Duplicates one or many selected IP ranges in the IP address list and adds them at the end.

Delete
Deletes one or many selected IP ranges.

Class B
Sets the last to octets of an IP range to x.x.0.1 to x.x.255.255, leaving the first two octets untouched.

Class C
Sets the last octet of an IP range to x.x.x.1 to x.x.x.255, leaving the first three octets untouched.

Ping Timeout
Limits the number of seconds to wait before assuming the computer is turned off or disconnected
from the network. Default is 1 second.

Ping Count
Limits the number of times to ping before assuming the computer is turned off or disconnected from
the network. This option is useful on busy networks where ICMP packets may get lost. Default is 3.

Ping Timeout and Count settings are independent of their counterparts under Preferences/Ping
Options.

IP Range Table

Active
Checked ranges are discovered while unchecked ranges are ignored. Useful when temporary
disabling is needed.

Start IP
The start of an IP range.

End IP
The end of an IP range.

Total IPs
A total count for the IP range.

Comment
A comment about the range. To edit, double-click on the comment itself or click the comment once
and begin typing.
 



Other Options

Detect NetBIOS info (Name verify/MAC/Group/User)
This option sends out a NetBIOS inquiry packet using the UDP (User Datagram Protocol) for
computers where the hostname is resolvable. The same method is used by the "nbtstat" DOS
command.

Detect Operating Systems (requires user-level access)
Attempts to retrieve the Operating System version (i.e., Windows XP) using empty, or anonymous
credentials. NEWT Professional's credential system 

IP Filter Options
These mutually exclusive options allow filtering of IP discovery results. All options are governed by
the Ping Timeout and Count.

Show both alive and dead IPs in selected range
Disables filtering and shows all IPs in the consecutive range. This option can reveal those IPs
within a range that are not in use. 

Show live hosts
Only show hosts which return pings.

Show live hosts with resolvable hostnames (Windows® machines)
Limits results to devices where the hostname can be resolved. These are usually Windows-
based computers.

Scan only machines with valid Operating Systems (Scan Mode Only)
When scanning by IP address, this option will scan only those computers which return an operating
system.

Skip Broadcast IPs (xxx.xxx.xxx.0 and xxx.xxx.xxx.255)
On every network and subnet, two addresses are reserved as "broadcast" IPs. At the low end range
of addresses for the network or subnet is the address (xxx.xxx.xxx.0) for the network or subnet itself.
The address at the high end range of addresses (xxx.xxx.xxx.255) is the broadcast address. Any
message sent to a broadcast address will be received by every host on the network. This option skips
these 2 IP addresses for all ranges.

Optimal column layout (Primary tab)
Arranges related columns in the Primary tab in a way so they're optimally visible.

Skip "Expired In Transit" TTL ping replies
Some routers return pings for many or all IP addresses even though no device is connected to the
address. This option provides the ability to filter out "Expired In Transit" replies and, in most cases,
can be left enabled.  Technically, all "Expired In Transit" replies have a TTL number of 42, although
the TTL is not displayed for unresponsive IPs. This number may be changed by the user.



See Ping TTL under Scan Properties for more information.

Switch to Scanning mode
This button switches between scanning and discovery modes. In scanning mode, discovery is
performed, then scanning is performed automatically. In discovery mode, only discovery is
performed, scanning must be initiated manually.

Clear Previous Results
When enabled, all results are cleared before a discovery or scan is made.  Disabling the option
allows discovery of devices or computers that may have been turned off or unavailable during a
previous scan or discovery, while keeping the current results or list.  Enabled by default.

Buttons

Discover or Scan
Initiates discovery or scanning.

Close
Exits the window.



NEWT Professional Credentials System

Custom credentials are used to provide a custom username and password to gain access to remote
computers. Credentials are needed when an empty username/password connection is denied.
Credentials are usually needed for remote computers when the username & password are different
from the local machine, or the computer you're scanning from.

When logged into a domain, one only needs to make their username part of the Domain Admin group
to gain complete access to all computers logged onto that domain. Trust relationships are usually the
best method to allow access between multiple domains, but a "domain\username" credential may
also be used.

The Credential Manager allows input of custom credentials on a per machine basis. This is designed
to allow ultimate flexibility when gaining access to remote computers.

Credentials are checked in 2 basic phases.
1. Access to the remote computer is checked without credentials (blank username/password), if the
Empty credentials option is enabled.
2. In cases where sufficient access isn't gained using empty credentials, if a Default
Username/Password is entered and credentials aren't entered in the Credential Manager for the
computer's name being scanned, the Default Username/Password is tried. If access is gained using



the Default Username/Password, an entry is created automatically in the Credential Manager for that
computer.

NOTE: The account using custom credentials must have administrator privileges.

Access Status

This information is useful for troubleshooting a connection problem. These are duplicated and shared
by the last three columns of the Network Browser and can be seen in the Primary tab by selecting
"Show Credential Columns" under the View menu. 

Machine name
The computer name for the currently selected credential.

Authentication
Describes what type authentication was successful or failed. Can be one of the following:
Empty - Indicates only Blank credentials were used
Default - Using the Default Username/Password in Preferences 
Custom - Using a custom credential as entered in the Credential Manager.

Error Type
Describes at what stage the error occurred. This can be one of the following stages NEWT
Professional uses to check access to a remote computer:
1st stage: Machine Connect - General connection to the remote computer.
2nd stage: Registry Open - The registry could not be opened remotely.
3rd stage: Registry Read - The remote registry path of
"SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall" cannot be read.

Access is assumed granted if all 3 connections are made. Note that WMI has not yet been integrated
into the credential management system and must be dealt with separately.

Error Description
A standard Windows message describing the error in plain English along with the Windows numeric
error code.
 



Machine Details

Reached by double-clicking a computer in any the main interface tabs, the Machine Details window
shows information about a single computer in a concise, easily readable view.  Selecting machines in
the main interface changes the display to the selected computer.

ExportThis feature allows exporting of all items about a single computer in text or HTML format.

Autowidth
Sizes grid columns in all tabs to fit the data or header, whichever is longest.



Exporting

Export all...Export of all data for the selected tab as a CSV, HTML, text or Excel (XLS) files.

Export selected machines
Export of all data for selected machines in the selected tab as a CSV, HTML, text or Excel (XLS)
files.

Export to Microsoft Access (MDB)
Allows exporting to a fully relational Microsoft Access 2000 (MDB) file.  This allows printable
reports to be made and contains several useful built-in queries are available.



Itemize Tool

Accessed by right-clicking a computer in any the main interface tabs and choosing "Itemize" from the
menu, the Itemize Tool filters and counts any item.  The Itemize Tool is also reachable from the Tools
menu.

Below are just a few examples of the many possible uses for the Itemize tool.

 

 



Tab Manager

Accessible from the Tools menu, the Tab Manager provides easier viewing and manipulation of
columns.  All columns are represented here and can be rearranged in any order necessary.

Show selected columnInteractively shows selected column for the selected tab in the main interface.

Show column during scroll
Scrolls the selected main interface in real time as the Tab Manager is scrolled vertically by the user.

Column dragging
Enabled or disables the ability to rearrange columns from this view.



Options

Search DirectionSelect the appropriate radio button to search up or down from the currently
selected row.

Item Limit
May be set to search within the selected column or all columns.

Colorize Found Data
Selecting “Colorize Found Data” will highlight the cell the text is found in each time the “Find”
button(s) are clicked.  To remove the colorization, click the “Cancel” button (this will also unhide
any rows that have been hidden).

Match Case
When selected, the found data must exactly match the case of the search term.

Match whole word only
Only the whole word will be found, not words that contain the search word.

Buttons

Find First



Finds the first instance of the search term.  Results are displayed in the grid and the table at the
bottom of the Search and Filter window.

Find Next
Finds the next instance of the search term.  Results are displayed in the grid and the table at the
bottom of the Search and Filter window.

Filter Include
Shows rows that contain the search text within the data.

Filter Exclude
Shows rows that do NOT contain the selected text.

Cancel
Exits the window.



Group Information

Accessible from the Tools menu, the Group Information too allows scanning of groups to determine
the type and Primary Domain Controller, if any.  Clicking the Scan button starts the operation.



The Scanning tab of the Preferences menu allows changes to how NEWT
Professional conducts scans

Scanning

Smart ScanEnabled by default, this option is linked to the main interface's green toolbar button.
When the toolbar scan button is clicked, NEWT Professional will determine what machines to scan
based on selections in the Network Browser or the tabbed grids. Disabling this option will cause
clicking the the toolbar scan button to open the scanning window for group selection. The scan
window can be accessed directly using the pulldown menu to the right of the green toolbar scan
button or through the Tools menu, by-passing the Smart Scan feature as needed.

Autowidth columns of current tab after scanning each machine
When enabled, all column widths on the currently selected tab resize to the smallest possible size
after scanning completes on a single machine. Enabled by default.

Autowidth columns of all tabs after completing entire scan



When enabled, all column widths on the currently selected tab resize to the smallest possible size
after the entire scan completes. Enabled by default.

Disconnect after scanning each machine
This option disconnects from each machine after scanning it unless the connection is required by an
application on the local machine.

Force Disconnection
When enabled, a disconnection is forced regardless of whether an application running needs the
connection or not. WARNING: This should only be used by advanced users when necessary.

Scan NetBIOS items (Group, OS, OS Type (DB), Comment)
Disabled by default, this option causes NEWT to scan all NetBIOS items. These items are ghosted
on the Scan Properties window.

Increased MTU compatibility (slows scan)
This option helps compatibility issues with any local machine that has a MTU setting below the
optimum default of 1500.

Scan Item Timeout

Number of seconds the scanner waits until skipping an item and moving on to the next. Default is 120
seconds.

Ping Options (Scan Only)

These options affect how NEWT Professional uses ping replies for scanning remote computers. Ping
options for scanning differ from IP Discovery/Scanning items of the same name.

Ping Timeout
Limits the number of seconds to wait before assuming the computer is turned off or disconnected
from the network. Default is 1 second.

Ping Count
Limits the number of times to ping before assuming the computer is turned off or disconnected from
the network. This option is useful on busy networks where ICMP packets may get lost. Default is 3.

Require Ping Reply
When enabled, NEWT Professional attempts to resolve each computer to an IP address and pings it
using Ping Timeout and Count settings. If the computer can't be resolved to an IP address or properly
pinged, the computer is assumed turned off or disconnected. It is then marked as such and skipped.

Disabling this option causes NEWT to scan the computer without requiring a ping reply. This is
useful when networked machines have their ICMP disabled for security reasons.



This option is enabled by default.

Credentials

The following options affect the behavior of NEWT Professional's credential system.

Please see the Credentials section for more information on the credentials system.

Try Empty credentials (recommended)
This feature tries "Empty" credentials first to see if access is given anonymously. This option should
only be turned off under special circumstances. See Credentials for more information.

Check Speed
Changes the speed of credential checking when choosing Check Credentials.

Default Username & Password
This username and password are tried when empty credentials fail and if credentials are not found in
the Credentials Manager for the machine being scanned.

Custom Credential Manager
Opens the Credential Manager from Preferences. This window can also be accessed from right-click
contextual menus in the main interface tabs and Network Browser as well as the Tools menu.   It may
also be accessed by double-clicking a computer under the Network Browser.

Scan Speed

Changes the speed during a scan. By default no time elapses between each item. Slowing down the
scan uses less network resources, but also causes a scan to take longer.

Buttons

Scan Properties
Opens the Scan Properties window. This window can also be accessed from the toolbar of the main
interface.

OK
Closes preferences window and applies any changes

Cancel
Closes preferences window and disregards any changes
 



The Interface tab of the Preferences menu allows changes to the look and feel
of NEWT Professional

Tab Behavior

Auto-Gang SelectionWhen enabled NEWT Professional will auto-select the first row of the
selected computer in each tab. This option can slow down selections considerably. Disabled by
default.

Hint: An alternate is to use the "Gang Selection" command under the View menu. This gang-selects
the clicked on all tabs only when needed.

Multi-Row Tabs
Enabled by default, this option causes the tabs of the main interface to automatically change size and
position so all tabs are visible independent of the window size. Disabling the option keeps the tabs
on one a single line. A set of arrows appear when the window is sized too small to show all tabs.



Color

This section allows control the look of the main GUI and Machine Details grids.

Text Color
When enabled, causes grid text to become the color in the box to the right of the option. Enabled by
default.

Alternating Odd Row Color
When enabled, causes grid's background odd rows to be the color in the box to the right of the
option. Enabled by default.

Alternating Even Row Color
When enabled, causes grid's background even rows to be the color in the box to the right of the
option. Enabled by default.

Miscellaneous

Expand Computers Near Me on start
Enabled by default, this option will open and show computers in your workgroup or domain
automatically at program start.

Use realtime OS Type (DB) detection
This causes the OS type (i.e., professional, server) to be determined in the Network Browser in
realtime. Enabled by default.

Include Active Directory
Enabling this option forces a cross-reference of the Windows Computer Browser and Active
Directory when browsing through the Network Browser or discovering/scanning by group.
Computers found in Active Directory, but not in the Computer Browser service is marked by a
"Computer off?" status. An unexpected benefit of this feature prompts users to clean up the Active
Directory. Disabled by default.

Hot Fixes Lookup URL Prefix

This URL prefix is used when clicking a hot fix article item under the Hot Fixes tab. This allows the
user to change the prefix in the future if needed.

File Operations

Use column position settings from MRF/MRE
Column positions on the main interface are saved with every MRF or MRE scan result file. This
option changes the behavior of column positions when loading scan results.



Always
Forces NEWT Professional to always use the column settings when loading the scan result file.
Ask first
Prompts every time a file is loaded.
Never
Causes NEWT Professional to ignore any column settings in the scan result file. This is the
default setting.

When exiting
Controls behavior when exiting the application.

Prompt to save
The default setting, this option prompts the user to save any unsaved scan results.
Save file without prompt
This option will always save the file without prompting to do so.
Exit without saving
This option causes NEWT Professional to close without saving scan results and without
prompting the user.

Verify files when saving or exporting
The verify files option compares all file saves and exports except XLS and Microsoft Access
(MDB) files. Enabled by default and highly recommended.

Buttons

Scan Properties
Opens the Scan Properties window. This window can also be accessed from the toolbar of the main
interface.

OK
Closes preferences window and applies any changes

Cancel
Closes preferences window and disregards any changes

 

 



 



Support

ForumsOur forums provide a self-help area for all users where many
questions may have already been answered.  Visit
http://www.komodolabs.com/KomodoForum directly to post questions or
read more about a particular issue.  News and feature requests are also
available through the forums.

Contact technical support
To contact support directly, please email support@komodolabs.com.  Please
allow at least one day for replies.

http://www.komodolabs.com/KomodoForum
mailto:support@komodolabs.com
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